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Example 1 — File compression, or “zipping”

Exercise 1 Download and install software

You will need an appropriate software application in order to compress and
decompress files. There are many to choose from, but we are going to download

an evaluation copy of the WinZip software.
You will need an Internet connection.

Example 2 below explains virus checking. It is always important to ensure that a
virus checker is installed and running before downloading anything from the

Internet.

. . T
* Click the [Start] button once with your left mouse button

0 The [Start] menu appears
* Click [All Programs]
0 A sub menu appears (e

» Either click [Internet Explorer]

or

* Click [Netscape Navigator]

or
* Click your browser software name
0 Your computer starts the procedure to connect to the Internet

o A new Web browser application window opens

» Click onto the long white Internet address strip near the top of the Browser
window

0 To select the current Web address
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o Type “WWW.Wan|p.C0m/ddCh0men-htm” | Address |@ hitp: /. winizip.caom./ddchomen. bt ﬁ

o Toinsert a new web address
* Press [Enter] on the keyboard
o0 To go to that Web site address
o To display that Web page
e This page links to a number of different sites from which to download WinZip,

as well as containing useful installation instructions, and other advice.

| | [NJWNII]AD
e Click to follow a download link such as [Download.Com]
o The [File Download] window opens
e Click [Save]
0 To choose to save the file to your computer
File Download =3

-» Some fileg can harm your computer. [F the file information below
‘“-‘:r/ look.s suspicious, or pou do ot fully trust the source, do not open ar
zave this file.
File name: winzips1.exe
File type:  Application

Frarn: Ftpx . dowenload. com

& Thig type of file could harm pour computer if it contains
rmalicious code.

“whould pou like to open the file or save it bo your computer’?

[ Open ] [ Save )[ Cancel ] [ Mare Infa ]

» Click the small down facing arrow to the right of the [Save in] list
o0 To see a list of available places to save your work to
« Select [Desktop] and click [Save]
o To save your work to the Windows Desktop area
o To see a [% Completed] window as the files download from the Internet to

your computer
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e
Sm‘: [ Deskicp ~ ) F e M-
5 My Documers
__‘_’ o My Computer
MyRecent Sy Natwork Maces
Diecumerils
w Saving:
Deskiop winzipa1.exe from Ftpx.download.com
(Eeees )
Estimated time left 13 min 30 sec (226 KB of 1.80 ME copied)
s LLIE Download ko Ci\Documents and Sett,, winzipel exe
" Transfer rate: 2,28 KBfSec
31-'! [ Claze this dialog box when download completes
My Computer
Flerane M v
My Netwark  Save as lype: Application - Cancel

* When the File Download window appears showing Download Complete,
select [Close]
Select the [File] menu and [Close]
0 To close the Download.com browser window

« Double click the [WinZip] set up icon on the Windows Desktop
0 To begin installing WinZip

WinzIpa 1

* The WinZip Setup dialog box open
* Click [Setup]
0 To begin installing the software
* In the next setup screen, click [OK]
0 To accept the place that the software will be saved to (in the example it is
a new WinZip folder in the Program Files folder on the C:\ drive) — or click
[Browse] to select your own file path.

o To continue the installation

Setup will inztall WinEip inta the following folder, which it waill
create if neceszam.

[f you want ta inztall Windip in a different folder anddor drive,
twpe the name of the folder below:

[nztall ba

C:%Program Filezhwingip [ Browse. .. ]

<>
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In the Thank you setup screen, click [Next]

3

se!ui Thank. you for your interest in Winipl Setup

Click the "Setup” button to install \Wingip 8.1 5R-1.
Cancel

Info...

In the License Agreement and Warranty Disclaimer screen, be sure that you

License Agreement and Warranty Disclaimer

Az with other goftware, Windip iz subject to WARRANTY DISCLAIMERS and
LIABILITY LIMITATIOMS, including [but nat limited to] the following:

THIS SOFTWARE, ARD ALL ACCOMPANYING FILES, DATA AWND MATERIALS, ARE
DISTRIBUTED “AS 5", and ANY LIAEILITY OF WINZIP COMPUTING, INC. WILL BE
LIMITED EXCLUSMWELY TO REFUND OF PURCHASE PRICE.

In addition, this werzion of Winip iz zubject to the complate
WinZip License Agreement, which you can view by clicking on the
"Wiew Licenze Agreement’ button now,

| agree that by clicking on the "Yes" button below [or otherwizse installing
or using *WinZip), | accept all terms of the Licenze Agreement, and that |
have read the License Agreement.

Tes | Mo | i Wiew License Agreement I

agree with all of the terms and conditions before clicking the [Yes] button

In the Quick Start setup screen, click [Print Quick Start]

o To print a copy of the Guide or help information

Click [Next]

Windip Setup

WinZip Quick Start

For helpiul information on instaling and using 'WinZip, print a
copy of the “winZip Quick Start Guide." Click. the *“Print Quick.
Start” button.

To see the Guide without printing it, click on the "View Quick
Start” button.

‘You can also view or print the Quick Start Guide lates by
selecting Quick. Start from the WinZip Help Contents.

Click on Mest when you are ready to conbinue,

Print Duick Start | View Quick Start |

Hep | _ <Back
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In the Wizard or Classic setup screen, mark the option to [Start with WinZip
Classic]
Click [Next]

Windip Setup

Select “Wizard™ or “Classic”, then click “Next™

You can start with the “wizard™ o "Classic” interface. It is easy
1o switch b the: two interf. and you can sways
change the default later.

The Wizard sutomates the most common tasks invelving Zip files
and is ideal if you want to quickly unzip files of install software
distributed in Zip files.

 Start with the WinZip Wizard

‘Winip Classic is much more powerful and is recommended if
you are comfortable wath Windows and Zip fles.

% Start with WinZip Classic

o | oot [o] o |

In the next setup screen, mark the [Express setup] option
Click [Next]

Click “Next” to proceed.

% Express setup [recommended)
" Custom setup [for advanced users)
Ewxpress Setup associates Windip with archives, creates a

program group, and puts WinZip icons on the desktop and
Start menu.

Hep | <Back | Mem> Close

In the association setup screen, click [Next]

WinZip Setup

Winfip needs to associate itself with your archives.

Aszsociahions allow WinZip to be uzed to open archives from ky
Computer, Windows Explorer, etc.

Click "Mext" to associate Winip with all supported archive

types. Chck "Associations' if you want more information or would
like to specify the archive types with which WinZip is associated.

Azzociations...

’ Help ][ < Back ” Next > ][ Cloze
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* In the Thank you setup screen, click in the [Delete the installation file:] field,
then click [Finish]

To put a tick in the [Delete installation file:] field
To delete the now redundant setup file EE:
To complete the setup of your WinZip software Wii

To add a WinZip icon to your windows Desktop

To add a WinZip shortcut on the [Start] [All Programs] menu

O O O o o o

To open WinZip

WinZip Setup

Thank you for installing thiz evaluation version.

Far a list af new features in thiz releaze. pleaze see the ""wWhat's
MHew'" section of the help file or presz the F1 kep now.

Click. "Finizh'' to start Winip.

v Delete the installation filed
C:wINDOWSADESKTOPYWINZIFET EXE

Help < Each I Finizh I Cloze

© Aston Swann 2006 71



ICDL for Educators Courseware — Using the Computer & Managing Files

Module 2 Part 2

Tip:

For your information only.

To remove a software application and all of its components from your computer

(i.e. to “uninstall” a programme):

Either:

Select the [Start] button and [All Programs]

Select the name of the Program you wish to uninstall and look for an

[Uninstall] option in the menu

or

Select the [Start] button and [Control Panel]

0 To open the [Control Panel] window

Click [Add or Remove Programs] oo
o The [Add or Remove Programs] window opens
Scroll through the list and click to select the program you wish to uninstall
Click the [Change/Remove] button and follow the prompts
o To remove that program from your computer
% S=5|
. 'I__ Currently installed programs: Sort by: | Name v
CRb:rﬁ_ff [P Microsoft Office XP Media Content Size  B7.99MB
Programs [P ticrosoft Office 3P Professional Siee  212.00MB
y 7 NEXDISK Sige  3.40MB
1" §5! UsB-Flash Disk Sze  0.80MB
:V?ért:; T s Size  4.63MB
Click here for support information. Used raraly
4'_, Last Used On 25/03/2003
Mdm_zw;uw To change this program or remave it from your computer, dick Change/Remove, [Change,rpemqu
‘Windows
Components
@

Set Program
Access and
Defaults
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Exercise 2 Understand file compression

A file that has been squeezed down using compression software is known as
“zipped”
Files that are compressed:

- travel faster between modems

- use up less memory

- are an ideal way of backing up data.

To return the file to its original size it must be decompressed or “unzipped”
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Exercise 3 Compress afile

* Insert your exercise CD into the CD drive of your PC

e Select the [Start] button, [My Computer], and click the [Folders] button on the
toolbar
o To view your filing system

* In the [Folders] pane, select your CD drive, and the [Module 2] [Part 2] sub-
folder
o To open that sub-folder in the Contents pane
0 To see the files saved in that folder

* Click the [compress_info.doc] file with the RIGHT mouse button
0 To see a quick menu of options

* Select the [WinZip] menu, and from the sub menu which opens, select [Add to
Zip file...]

o To open the [WinZip Evaluation] window

Marng Size Type
@W 31KB  Microsoft Word Doc...
Open
New
Prink

5can for Yiruses. .,

Cpen With »
Eﬂﬂ WinZip [ L‘@ Add to Zip file...
&) Add to compress_infa.zip

Send T

ena 1o &) Add to recently used Zin File »
Cut &) 7ip and E-Mail compress_info.zip
Copy &) Zip and E-Mail Plus, .,

Configure

Create Shortcut J Confg
Delete
Rename
Propetties

* Read the Evaluation notes
» Select the [I Agree] button
o0 The Add dialog box opens
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* Click [Open]
o0 To browse to the destination folder you wish to use
* Inthe Open Archive dialog box, click the drop down arrow to the right of the
[Look in:] field
» Select your [My Documents] folder
* Inthe [File name:] field, type “Compress_info” and click the [Open] button
e Click [Yes]
o0 To create a zip file called [Compress_info] in the [My Documents] folder
* In the Add dialog box, click [Add]
0 To compress the [compress_info.doc] document in the [Compress_info]
zip file in your [My Documents] folder
o The compressed document shows in the [WinZip] window
o The zip file will show in the [My Documents] folder in your My Computer
window
o In this example, compressing the document has reduced its size by 82%

o Some documents will compress better than others

!E'[! WinZip - compress_info.zip

Eile Actions Options  Help
. b (-rj . I_Er = @ O i
T = p L B - - pe i
| 4 [ ) - i e
o iy O RE 2w &g @
Tl Cpen Favarites Add Extract Wi Checkout  Wizard
Modified Size  Ratic  Packed Path
171042003 0., 31,232 B2% 5,533
Selected O Files, 0 bytes Total 1 File, 31KE a0

© Aston Swann 2006 75



ICDL for Educators Courseware — Using the Computer & Managing Files Module 2 Part 2

Exercise 4 Extract a zipped file

Work in My Computer

o To view the compress_info.zip] file

In the [Folders] pane, select your [My Documents] folder

* Click the zip file with the RIGHT mouse button

0 To see a quick menu of options

» Select [WinZip] and, from the sub menu which opens, select [Extract to here]

o The [WinZip Evaluation] window opens

* Read the Evaluation notes

» Select the [I Agree] button

o To place the extracted file in the same location as the zip file

Name

| Open with WinZip
Print
Explore

Scan For Viruses. ..

Open With
Send To
Cut

Copy

Create Shortcut
Delete
Rename

Properties

Sze Type Date Modified
6KB WinZip File 171042003 11:18
e Extract to...

[l Extract to here
€9 Extract to folder C:\Documents and Settings) Training|My Documents\compress_info
€3 Extract to Folder 3
P E-Mail compress_info.zip
9 Create Sef-Extractor (Exe)
9 Configure

Note:

Selecting the first option [Extract to...] in the sub menu will allow you to select the

folder in which you wish to place the extracted file.

* [Close] the My Computer window
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Example 2 - Virus risks

Exercise 5 Understand what a virus is

If you like the idea of being able to download files from the Internet and to send
and receive compressed files, then it is best to be aware of the possibility of
viruses. Viruses are programs that hide within and affect other programmes.

A virus is man made. It is called a virus because it is easily caught. Viruses can
have many effects, some mild, some amusing and some devastating. All will try

to damage or change your data in some way. All are unwanted.

Viruses can affect your computer from a diskette, CD, downloaded Internet file,

zipped or compressed file or e-mail attachment.

Always virus check files that people send/give you, and never open an e-mail

attachment if you don’t know who it's from.

A virus might not make itself known straight away; it can lay dormant in your
computer until triggered by a particular event such as a date. The best way to
protect yourself from a computer virus is to install and use a virus “checking” or

virus “scanning” software application.

Although you might regularly use your virus-checking software on your computer,
remember that hundreds of new viruses are introduced every month and your

scanning programme is only as good as the last time you updated it.
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Use a virus checker/scanner

Either:
* Open your existing virus checking application
or
e Install a new virus checking application
or
» Connect to the Internet and use your new skills to download a virus checking

application.

Tip:

When downloading, check to see how large the file size might be. Sometimes it is
best to download the evaluation version of the programme first and purchase the
full version when the evaluation period expires.

Remember you can always click the [Cancel] button if you decide not to proceed

with the download at any stage.

Suggested sites:

Frisk software www.f-prot.com

Symantec www.symantec.com

McAfee www.mcafee.com

PC cillin http://uk.trendmicro-europe.com

Disinfecting your files

Virus scanners can be set to check in various ways:
- only when the computer starts up
- to stay in the background all the time the computer is on

- to be used to scan specific drives, files, and folders only when you want to.
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Virus scanners recognise the signatures of thousands of viruses and will stop
them before they become active. If a virus scanner programme identifies a virus it
will usually provide guidelines for dealing with it. The most common options are
to “ignore”, “delete” or “store and reconstruct” the infected file/s.

The scanning and disinfecting options of your virus checking programme can be

set and changed at any time.
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Exercise 6 Scan a drive for viruses

Open your virus checking programme

» Select to scan the [C] drive only for viruses (deselect the other drives)

™ Norton AntiVirus

EPDuveupaate () Help »
Scan for Viruses
Slals | Task Task Schedule
Scanforviruses 4 | &3 Scan my computer
= Scan all removable drives
Reports [ed Scan all Noppy disks
S Scan drives
1 Scanfolders
M scanfiles
Actions Schedule Task
pScan  »New » b »
Norton i\/i ™
,symantec. AntiVirus-zo:

The scan may take quite a while depending upon the size of the drive and the

number of files stored on it. It is usually possible to stop the scan part way
through if it is not convenient to complete at this time.

80
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Exercise 7 Scan a specific document for viruses

Either:

» Open your virus checking programme

» Select to scan [compress_info.doc] in your [My Documents] folder for viruses
(deselect any other options)
or

* From the Taskbar, select [Start] [My Computer]

* In the left hand pane of the [My Computer] window, select [My Documents]
o To list the contents of that drive in the right hand pane

* In the right hand pane, select [compress_info.doc] with a RIGHT mouse click
0 To see a quick menu of options

* From the quick menu, select the option to scan for viruses

0 To scan that specific document

Scan: Summary

1 Scan Progress

Summany Mo Infection found

2 Repair Wizard :
Scan time 17 second(s)
Fix = =
Action: Files Master Boot Record Boot Record
Quarantine Seanned 3 0 1
Delete & | Infected: 0 0 0
Repairad 0 0 0
3 Summary Guarantined 1]
Deleted: 0
Mare |nfa

Finished | [ More Details

Tip:

Use these techniques to scan a specific drive, folder or file at any time.
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Example 3 — Working with files

Exercise 8 Create and save a file

This will practise using the mouse whilst creating a file in Microsoft Paint.

* From the Taskbar, select [Start] [All Programs] [Accessories] [Paint]

» Experiment with the different drawing tools

* From the menu bar select [File] [Save]

» Select the [My Documents] icon to save your work, and give it the File name:
[Art]

» Select [Save]
0 To save the file

0 To close the dialog box

¥ art,bmp - Paint

v Image Colors  Help

o O
FrMEEC RN R

For Help, dick Help Topics on the Help Menu
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Exercise 9 Open your saved work

This exercise will use different methods to find and open your saved work

The [My Recent Documents] menu

From the Taskbar, select [Start] [My Recent Documents]

o The last 15 documents that you worked on will be listed
Click on your document file name from the list

o Toopenit

[Close] the Paint program

[My Computer]

From the Taskbar select [Start] [My Computer]

From the [Other Places] screen select [My Documents]

o The window will display the contents of [My Documents]
Double click the name of your document file

o Toopenit

[Close] the Paint program

Open the program then open the document

From the Taskbar select [Start] [All Programs] [Accessories] [Paint]
From the menu bar select [File] [Open]

Click on the drop down arrow to the right of the [Look In] list

0 A list showing all the drives on your computer will open

Double click the name of your document file

o To open it — then [Close] the Paint program.
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Using My Computer

The next exercises will use My Computer for several functions

We will use the Search function to search for the file we have just saved
We will copy a file within its own folder — creating a new file with a different
name

We will work with floppy disks within our filing, as well as using them to
store copies of our files

We will sort the files within their folders

84
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Exercise 10 Search for files and folders

Files and folders can be found from their attributes such as name, size, date
modified.

Find a file or folder by its name

If you know part of a file or folder's name, “wild card” characters can be used to
replace the part of the name that you are unsure about. The most frequently used
wild cards are the asterisk (*) and the question mark (?). The asterisk stands for
any number of characters (or no characters at all), whilst the question mark

stands for one character. As an example:

Name*.doc | Will find any file or folder that starts with the 4 | Name.doc
letters ‘name’, followed by any other
Names.doc
characters (or no more characters), followed
by a dot and the extension ‘doc’ Namesoffiles.doc
These examples would be found:
Name.* These examples of files and folders would be | Name.doc
found:
Name.bmp
Name
But these examples would not be found: Names.doc
Namesoffiles.bmp
Name?.doc | These examples would be found: Names.doc
Namel.doc
But these examples would not be found: Name.doc
Names.bmp
Na?e.doc These examples would be found: Name.doc
Nave.doc
Nape.doc

e From the Taskbar, select [Start] [My Computer]
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0 The [My Computer] folder will open

» Click the [Folders] button on the toolbar
o0 To view the folders pane

* From the toolbar click on the [Search] icon
0 The [Search] window will open

* In the Folders pane select [All Files and Folders]

&
O - @ - ) Fos | (5"
address | ) My Documents b Gu

X Name Sz Type Date Modied
JECDL Exercises - NS Fis Fokder 07)03/2003 11:00
(JECDLV4 P Fle Foder 21J03/2003 11:46
(Helen Fle Folder 20J05/2003 13:09
My msc Fie Fobder OS3FA003 14:41
(20 Pictures Fie Fokder 10J03/200% 14:49
N Sorme Bllacns brp I2KE Bhmap Image 25102/2003 14:58

What do you want to search for?
Pictures, music, of video
Dacurmerts (word pracessng, spreadehest,

3 Computers or peaie
) Information n Hep and Supooet Cerer
You may also want to...
&) searchthe Incermet
|4) Ghange preferences

* Inthe [All or part of the file name] field, type [Art*.*]
0 To search for any files or folders that start with the 3 letters ‘art’, followed
by any other number of characters, with any extension after the full stop
0 The [word or phase in the file] field would look for the specified text within
the body of a file, rather than looking for a file name
* Click on [More Advanced Options]
(It may be necessary to scroll down in the [Search Companion] pane to view
the [More Advanced Options] selection
* Ensure that there is a tick in the [Search subfolders] field
0 So that all the folders and drives on your system will be included in the
search
* Click [Search]
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0 To commence the search
o To begin to view a list of all the files and folders that meet your criteria

Search Companion x Search Campanian
-~
All or part of the File name: -~
Ark* # Lok in:

<

f My Computer
A word or phrase in the File:
When was it modified?

YWhat size is it?

o«

Look. in:
_.L!' [y Computer - More advanced options
- Type of file:
ﬂzs:}igj?s * = (Al Files and Folders) ~

Search system Folders

4

e e &Search hidden filas and Folders
Search subfolders
Z:::;Er?sdvanc‘::d Z St [ case sensitive
[] seatch tape backup i
[ Back. ] [ Search l Back ] [ search

Find a file or folder by the date it was created

This will narrow the search, to state that you are only interested in files and

folders beginning with the letters ‘art’ that were created today.

e Return to the Search Criteria box by selecting [Back] from your previous
search
* Leave the details on the [All or part of the file name] tab as they are
o0 So that you are still looking for files and folders containing the letters “Art”
» Select the [Specify Dates] option
» Click the drop down arrow in the box below the [Specify Dates] options and
select the [Created Date] option
0 To specify that it is the creation date you are interested in rather than
when the file or folder was last modified or viewed

* Click the drop down arrow to the right of the [From] date field
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e If you are unable to view the drop down arrow to the right of the [From] and
[To] date fields, it may be that your [Search Companion] pane needs to be
widened.

« Click on the thick line to the right of the [Search Companion] pane until a
double arrow is formed.

* Drag this double arrow to the right
o To widen the [Search Companion] pane
o To be able to access the date options within the [From] and [To] date

fields

» Select the current date on the calendar
o To specify that you only wish to find files and folders created today
0 Use the arrows for further dates/months

* Click the [Search] button
0 To commence the search
o To replace the list of files and folders shown that meet your criteria

* Return to the Search Criteria box by selecting [Back]

Search Companion

All or part of the file name: R
b+

A word or phrase in the File:

Look.in:

j My Computer Sy >
When was it modified? E

() Don't remember

() within the last week
() Past month July 2003

(0 Within b

pecify dates

Created Date ~

Mon Tue ‘Wed Thu Fri Sak Sun

1 2z 3 + N ¢
7 g 9 w11 12 13
14 15 16 17 1§ 19 20
21 22 23 24 25 2 27
28 29 30 3

from |0spo7/z003

05/07/2005

k. h
Back || searc [ IToday: 05/07,/2003
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Advanced Find

Using the [What is it?] and the [More Advanced Options] tabs in the Search
dialog box, it is also possible to specify:

» That you wish to view all files and folders of a particular size

» That you only wish to view files and/or folders of a particular type (for

example, Bitmap files)

View all files and folders by size

e Leave the [created date] previously selected as it is
o So that you are still looking for folders created today
» Using the scroll bar to the right of the Search window, scroll down until you
reach the [What size is it] section
* Select the double arrow to the right of this section
o To view the file size choices available (if the double arrow has previously
been selected you will already see the file size choices available to you)
» Select the button to the left of the [Small (less than 100KB)] details
* Select [Search]
0 To commence the search

o To search for all files and folders created today that are less than 100 KB

Search Companion x

(2 within the last week. a
C' Pask month
() within the past year
(?,' specify dates
Created Date N
from | 25052003 v

to | z8j03/2003 v

¥

What size is it?

() Don't remember

(%) small {less than 100 KB)
) Medium (less than 1 ME)

C' Large {more than 1 MEB)

() specify size {in KB)

[ Back ] [ Search

* Click the [Close] icon above the [Search] area

o The [My Computer] window should still be open on the screen
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Exercise 11 Copy or duplicate afile

This will make a copy of the [Some Balloons.bmp] file in the [My Documents]

folder. The only difference will be the file name.

* In the Folders pane, click on the [My Documents] folder
0 To see the sub-folders within this folder listed in the Folders pane
o To view its contents in the Contents pane
o To see a “-“sign next to the [My Documents] folder
* In the Contents pane, select the [Some Balloons.bmp] file
* From the menu bar, select [Edit] [Copy]
o To put a copy of this file in the Windows clipboard
* From the menu, select [Edit] [Paste]
0 To paste a copy of this file in the [My Documents] folder
o The copy will be called [Copy of Some Balloons.bmp]
* Now select the [Copy of Some Balloons.bmp] file
* From the menu bar select [Edit] [Copy]
0 To put a copy of this file on the Windows clipboard
* From the menu bar select the [Edit] [Paste]
o To create a second copy of this file in the [My Documents[ folder

o0 The second copy will be called [Copy of Copy of Some Balloons.bmp]

™ My Documents =] E|E
File Edt ‘iew Favorkes Jooks Help H
) » & 2 | s
3 Back V) sewch Foiders | [[31]
Folders M Mame Size Type Date Modified ~
(& Desitop A | chessCub_files File Foider 13/07/2004 11:56
= () My Documents (<l My Data Sources File Folder 22/07/2004 15:39
) ChessChub_files My Downloads File Folder ¥
(2] My Daka Sources )My eBaoks File Folder
=4 My Downloads My Music File Foider
) My sBaoks Clihigel File Folder
# 2 My Music CIpdfaes_fies File Foidler
) haged ) pdfEdE99S Customize your POF do... File Folder 19/112003 12:46
) pdFo9s_files ) SurmmitSklls_files File Folder 15/01/2004 15:33
2) pFEAR99S Customize your PDF documents with sase_files tuter od files File Folder 15/06/2004 12:04
£ Summitskils_files = MevaP_PLpdf 2,628 K8 Adobe Acrobst Doc...  19/11/2003 13:03
£ butor cd files. ) Copy of Copy of Some Baloons. bmp 1,687 KB bp Tmage 11/08/2004 10:12
= § My Computer Bl Copy of Same Balloons. bmp 1,687 KB bmp Image 11/08/2004 10:12
# M 3% Floppy (A:) B ] Some Balloons,bmp 1,687 KB bmp Image 11/08/2004 10:12
# e Local Disk (C1)
£ b DVDICD-RW Drive (D)
= W ervvy on i o seever’ (B2

Tip:
Use the same “copy and paste” technique to duplicate files and folders between

drives.
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Exercise 12 Work with removable disks

Floppy disks, zip disks and other removable disks provide a useful means of
keeping backup copies of your files, or transferring files from one computer to

another when it is not possible to do this electronically.

Having a “backup” of any critical information is essential in case the original
documents are damaged.

It should be remembered that floppy disks are more susceptible to damage than
your hard disk or network drive, and that you can only store a very small amount
of information on each one, whereas Zip disks enable you to compress

information and therefore store more.

Other removable disks are becoming more widely available, and can range in

size from a few megabytes to several gigabytes.

Format a floppy disk

Formatting a disk will completely “clean” the disk — removing anything that was
previously stored on it. Care should therefore be taken before doing this to
ensure that there is nothing on the disk that needs to be kept. This can be most

easily done by viewing its content within [My Computer].

* Ensure that the [My Computer] window is open on screen
e Put the floppy disk in the a:\ drive of your computer
o Ensure that the silver cover of the floppy disk is pointing towards the
computer, with the round middle of the floppy disk underneath (not visible
as you insert the disk).
* From the toolbar, select [Folders]
* In the Folders pane, select the [3 ¥z Floppy (a:)] drive

* Look at the contents of the floppy disk in the Contents pane
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0 To ensure that it does not contain any essential files

* From the menu bar, select [File] [3 %2 Floppy (a:)] [Format...]
0 The Format dialog box will open

* In the Format Options section, select [Quick Format]
0 To quickly clean the disk of existing files

* Inthe [Volume Label:] field, type a suitable name for your disk
0 The name can be up to 11 characters long

* Click the [Start] button
o To begin formatting the disk

* Once the disk has been formatted, the Format Complete dialog box will
appear
0 To confirm the format is complete

» Click the [OK] button in the Format Complete dialog box

Capacity:

13.5", 1.44MB, 512 bytes/sector v |
File system

FaT v

Allacation unit size

| Default allocation size w |

Wolume label

Formak aptions

[ uick Format
Enable Compression
[ ]create an M5-D0O3 startup disk

L]
| ] \lq) Format Complete.
Skart ] [ Close
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Formatting a removable disk

Zip disks and other removable disks can also be formatted. The procedure to be
followed varies from disk to disk. It may be done in a very similar way to
formatting a floppy disk — as covered above — or the individual disks may contain

their own instructions to follow in order to format them.

Backup to aremovable disk

Files can be copied to floppy disk or other removable disks to be kept as a
backup copy. It is easy to do this in exactly the same way as copying to any other

drive or folder.

* Ensure that your floppy disk or other removable disk is inserted in the
computer

* In the Folders pane, click on the [My Documents] folder
o To view its contents in the Contents pane

« In the Contents pane, select the [Art.omp] file

* From the menu bar, select [Edit] [Copy]
o To copy this file to the Windows clipboard

* If necessary, in the Folders pane, click the “+” next to the [My Computer]
folder
o To view all your drives

* Inthe Folders pane, select your removable disk

* From the menu bar, select [Edit] [Paste]
0 To paste a copy of the [Art.bmp] file onto your removable disk
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Exercise 13 Select and work with multiple files

It is possible to select more than one file or folder at a time, when working within
[My Computer]. This enables you to move or copy all the selected files and/or
folders to a new folder or drive at the same time. If multiple folders are selected,

all the files within these folders will also be moved within their folders.

* Inthe Folders pane, select the [My Documents] folder

o To view its contents in the Contents pane

Select one file or folder

* In the Contents pane, click on the file or folder you wish to select

Select non-adjacent files and/or folders

* In the Contents pane, click on the first file or folder you wish to select
0 To select that file or folder
e On the keyboard, hold down the [Ctrl] key
* Whilst the [Ctrl] key is held down, click on the next file or folder you wish to
select in the Contents pane.
0 To select that file or folder in addition to the first file or folder you selected
* Whilst the [Ctrl] key is still held down, it is possible to select as many other file

and/or folders as you need in the Contents pane by clicking on them one at a

time.
& Ay Documents E|@g‘,
Fie Edit View Favorites Tools Help "
. 1 S sesch |2 Folders | [T+
) My Documents v B
Folders x Narme Size  Type Dake Modified
:_.) Desktop __JECDL Exercises - NS5 File Folder 0703/2003 10:00
= ) My Documents CJECDL V4 %P File Folder 21/03{2003 10:46
# | ECDL Exercises - NS ) Helen File Folder 18/03/2003 09:46
# [ ECDL V4 XP AMy Music File Folder 05/03{2003 13:41
# () Helen My Pictures File Folder 10/03/2003 13:49
_?' My Music mnn.doc 20KB  Microsoft Word Doc...  25/03{2003 14:04
J My Pictures ISKB Microsoft Excel Wor,., D6/03/2003 17:18
3 W My Computer E 352KB  Bitmap Image 25/02/2003 13:58
# % My Network Places 4 Copy of Some Balloons. bmp 352KB  Bitmap Image 25[02/2003 13:58
# Recyde Bin Iai]School timetables. s 24KB  Microsoft Excel Wor... 06/03{2003 18:41
“\Some Balloons. bmp J5ZKE Bitmap Image 25/02/2003 13:58
B)test 18303.doc 1,603KB  Microsoft Word Doc...  18/03/2003 11:45
] rest document. doc 20KB  Microsoft Word Doc...  17/03/2003 11:48
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To deselect one of the selected files or folders

* Hold down the [Ctrl] key
* Click on one of the selected files or folders
0 To deselect that file or folder

o To leave selected the remaining files and/or folders

To select a group of adjacent files and/ or folders

* In the Contents pane, click on the file or folder at the top or bottom of the list
of files and/or folders that you wish to select

* On the keyboard, hold down the [Shift] key

* In the Contents pane, click on the file or folder at the other end of the list that
you wish to select

0 To select all adjacent files and/or folders in a block

& My Documents EJE'E'
i

File Edt ‘iew Favortes Tools Help
? p, Search ||| Folders ] b
i) My Documents L ﬂ Go

Folders x Name See  Type Diate Modified
LZ} Desktop _JECDL Exercises - NS File Folder 07/03{2003 10:00
= |} My Documents CJECDL v4 XP File Folder 21/03{2003 10:46
# | ECDL Exercises - NS ) Heden File Folder 18/03/2003 09:46
£ ) ECDL V4 XP N by pusic File Falder 05/03/2003 13:41
# 3 Helen __'lMy Pictures File Folder 10/03f2003 13:49
A My Music ) art. doc 20KB  Microsoft Word Doc...  25/03/2003 14:04
2 My Pictures Iaj:'lclass Register For School trip. ds 1SKE  Microsoft Excel Wor...  06/03/2003 17:18
® W My Computer L Copy of Copy of Some Balloo... 352KB Bitmap Image 25/02f2003 13:56
# % My Network Places Copy of Some Balloans.bmp 352KB Bitmap Image 25/02/2003 13:58
& Recycle Bin 24KB  Microsoft Excel Wor...  D6/03/2003 18:41
352KB Bitmap Image Z5/02f2003 13:58
1,603KB Microsoft Word Doc...  18/03/2003 11:45
-4fl Test document.doc 20KB Microsoft Word Doc...  17/03/2003 11:48

To deselect one of the file or folders

* Hold down the [Ctrl] key
e Click on one of the selected adjacent files or folders
0 To deselect that one file or folder
o0 To leave selected the remaining files and/ or folders

Tip:

The number of objects selected is shown at the left of the status bar
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Sorting files

e Select the [My Documents] folder

* Ensure you are in the [Details] view by selecting the [Views] icon in the
toolbar and [Details]

* In the Contents pane, click the [Name] heading
o0 To see the contents of the folder sorted alphabetically from A to Z

0 To see the sub folders placed before the files

Mame Size  Tvpe Date Modified
I)Farm 1 File Folder 070712003 19:46
IL)Form 2 File Folder 07/0712003 19:46
IL)Form 3 File Folder 07/0712003 19:45
I)Farm 4 File Folder 070712003 19:43
jMy Music File Folder 31/05/2003 21:52
ﬂMy Pictures File Folder 26/06/2003 21:42
[= art 352KE  Bitmap Image 07072003 20:06
compress_info 26 KB Microsoft Word Doc,.,  23/11/200011:25
compress_info 4 KE MimarSinan Codex 07/0712003 20:01
,:'J, Some Balloons 352 KB Bitmap Image 07/07/2003 19:35

* Click the [Name] heading again
0 To see the contents of the folder stored alphabetically from Z to A

o0 To see the files placed before the sub folders

<V Mame ) Size  Type Date Modified
l ome Balloons 352 KB Bitmap Image 07/07/2003 19:35
compress_info 4 KB MimarSinan Codex 07/07/2003 20:01
@compress_info 26 KB Microsoft Word Doc..,  23/11/2000 11:25
(= art 352KB  Bitmap Image 07/07}2003 20:06
ﬂMy Pictures Fil= Faolder 26/06/2003 21:42
jMv Music Filz Folder 31/05/2003 21:52
I__)Form 4 File Falder 07/07/2003 19:48
I_JForm 3 Fil= Folder 070712003 19:48
\CZ)Form 2 File Folder 07/07/2003 19:46
I_JForm 1 Filz Faolder 07/07/2003 19146

* Click the [Size] heading at the top of the [Contents] pane
0 To see the contents of the folders sorted by size

Mame < Size )ype Date Modified
ICJForm 1 File Folder 07/07/2003 19:46
ILJJFarm 2 File Folder 07)/07/2003 19:46
IJFarm 3 File Folder 07107/2003 19:45
IIFormn 4 File Folder 07107/2003 19:43
;a,My Music File Folder 31/05/2003 21:52
ﬂMy Pictures File Folder 26J06/2003 21142
compress_info 4 KB MimarSinan Codex 07/07/2003 20:01
@compress_infn 26 KB Microsoft word Doc..,  23/11/200011:25
[ At 352 KB Bitmap Image 07/07 2003 20:06
,j Some Balloons 352 KB  Bitmap Image 07/07/2003 19:35
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* Click the [Type] heading at the top of the [Contents] pane
0 To see the contents of the folder sorted by application type according to

each program

Marme: Size  (Tvpe Drake Maodified
CiForm 1 File 7 07/07}2003 19:46
[IFarm 2 File: Folder 07/0712003 19:46
\CZIForm 3 File Folder 07/07)2003 19:48
(Form 4 File Folder 070712003 19:45
;h,r\’ly Music File: Folder 31/05)2003 2152
:JIMV Pictures File Folder 26/06/2003 21:42
[*d art 352 KB  Biktmap Image 07/07}2003 20:06
,j Same Balloons 352 KB  Bitmap Image 07/07)2003 19:35
@compress_infn 26 KB  Microsoft Word Doc,..  23/11/200011:25
compress_info 4 KB  MimarSinan Codesx 07/07)2003 20:01

* Check the grey [Date Modified] tab at the top of the [Contents] folder
0 To see the contents of the folder sorted by date and time

————
Mame Size Type ake Modified

ﬂMv Music Filz Folder 31)05/2003 21,52
ﬂMv Pictures File Folder 26/06/2003 21:42
ILZ)Form 1 File Folder 07)07/2003 19:46
I_JForm 2 Filz Folder 07107/2003 19:46
) Form 4 File Folder 07/07/2003 19:45
IZJForm 3 File Folder 07/07/2003 19:45
@compress_info 26KE  Microsoft wword Doc,,,  23/11/2000 11:25
,j Some Balloons 352 KB Bitmap Image 07/07/2003 19:35
compress_info 4 KB MimarSinan Codex 0707/2003 20:01
[ art 352 KB Bitmap Image 07/07/2003 20:06

Counting files in a folder

When multiple files are selected, the status bar shows how many are currently

selected.

Consequently, if a folder is sorted by [Type], and then all the adjacent files of a
particular Type are selected, the status bar will show how many files of that Type

are in the current folder.

For a quick count of the number of files and sub folders contained within a
particular folder, use the quick menu:

« In the Folders pane, select the folder you are interested in
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With the mouse pointer over this folder name in the Folders pane, click the
RIGHT mouse button

o To view the quick menu for folders

From the quick menu, select [Properties]

0 To open the Properties dialog box

Select the [General] tab

The [Contains:] section will list the number of files and folders within the
currently selected folder

Click [OK]

o To close the Properties dialog box

Target | General | Sharing
—J iy Documents
Type: File Folder
Location: CADocuments and Settingsh\Aston Swann
Size: 8.56 MB [8,984,532 bytes)
Size on dizk:  8.58 MB [3,007.104 butes)
Contains: 7 Files, 4 Folders
Created: 09 September 2003, 11:06:55
Aftributes:  [B] Read-only
[] Hidden
ak. ] [ Caticel

Change the file status (read-only, read-write)

Changing the “File Status” of a document to [read-only] allows the document to

be copied or read but not changed and saved. If a read-only file is changed, it

has to be saved under a new name.

Select the [My Documents] folder

98
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» Select the [Balloons.bmp] document with a single click
* Click the [File] menu on the toolbar
* Select the [Properties] menu
o The Balloons Properties window opens
* Mark the [Read-only] box with a tick and [OK]
o To change the file status to read-only

o To prevent changes being made to that file

Balloons. bmp Properties

General | summary

ﬂ Balloans.brp

Tvpe of file:  Bitmap Image

Size: 351 KE {360,054 bytes)

Size on disk: 352 KB {360,448 bytes)

Created: 25 March 2003, 19:52:44
Modified: 25 February 2003, 13:58:56

Arccessed; 25 March 2003, 21:38:38

P

Opens with: ‘ﬂ windows Pickure and F

Location: Ci\Documents and Settings' Trainingi iy Document

Attributes:  [#]Read-onk [ |Hidden

(o] 4 H Cancel H Apply

Tip:
Unmark the [Read-only] attributes box to be able to write to the file and make

changes
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Exercise 14 Copy a group of files to another folder

» Use your skills to select 3 of the files in the [My Documents] folder (see
previous exercises)

* From the menu bar, select [Edit] [Copy]
o To copy the 3 files to the Windows Clipboard

« In the Folders pane, select the folder you created with your department’s
name

* From the menu bar, select [Edit] [Paste]
o To copy the 3 files into your folder

File Edit View Favorites Tools Help Th
0 Back ~ () ? / Search | || Folders ’E b
Address |3 C:\Documenits and Settings\ Training|My Documents|Geography - Go
Folders X Name Size  Type Date Modified
(& Desktop (JForm 1 File Folder 01/04/2003 09:43
= ) My Dacuments JForm 2 File Folder 01/04/2003 09:43
+ | ECDL Exercises - NS __]Farm 3 File Folder 01/04/2003 09:43
# |) ECOL ¥4 XP 3 Copy of Copy of Some Balloo... I52KE  Bitmap Image 25/02/2003 14:58
] Geography 4 Copy of Some Balloons.bmp 352KB  Bitmap Image 25/02/2003 14:58
# L3 Helen 4 Some Balloons.bmp 352KB  Bitmap Image 25/02/2003 14:58
& My Music B ecoL.doc 34KB Microsoft Word Doc...  25/03f2003 22:22
2 My Pictures B art. doc 68KB Microsoft Word Doc...  25/03/2003 22:26
) Test Folder
# i My Computer
+ % My Network Places
& Recydle Bin
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Exercise 15 Create a shortcut on the Desktop

If you use a particular file regularly, it is possible to create a “shortcut” to this file

on the Desktop.

This means that each time you start your computer, the file is visible on the
Desktop as an icon. By double clicking on the icon the program in which the file

was created will be opened, with the file on screen ready to edit.

To create a shortcut to the [Some Balloons.bmp] file.

* Inthe Folders pane, select the [My Documents] folder
0 To see the contents of this folder in the Contents pane
* In the Contents pane, select [Some Balloons.bmp]
« From the menu bar, select [File] [Send To] [Desktop (create shortcut)]

o The shortcut will be placed on the desktop
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Exercise 16 Work with the shortcut

Once icons have been placed on the Desktop, it is possible to reposition the
icons as appropriate on the screen.

Viewing the Desktop

Either E
» Click the [Show Desktop] icon on your Taskbar
o To minimise all open programs onto the Taskbar
0 To view the Desktop
Or
e Click the [Minimise] button for each program you have open on @m
screen
o To minimise each program onto the Taskbar @
L

o To eventually view the Desktop

Shartout o
* View your new shortcut to your file on the Desktop Some Balloons

Determining how icons will behave
Icons can be arranged by name, type, size or date on the Desktop.

They can also be set up to allow the user to move them freely around the

Desktop, or be fixed to line up down the left hand side of the screen.

* Move the mouse pointer into an empty space on the Desktop
* Click the right mouse button

o To view a quick menu of options available for the Desktop
» Select [Arrange Icons By]
e Choose [by Name], [by Type], [by Size] or [by Date]

o To amend the order of the icons on the Desktop, if relevant
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* Click the right mouse button again
o To view the quick menu
» Select [Arrange Icons By]
» If there is a tick next to [Auto Arrange], click on this option
0 Toremove that tick
0 To enable the icons to move freely round the Desktop
* Move the mouse pointer over your new shortcut
» Click and hold the left mouse button
* Drag the shortcut to a new position on the Desktop
* Release the left mouse button

o To place the shortcut in this new position

MNarne Arrange Icons By
Size Refresh
Type |
Madified Paste
Paste Shortcut
Undo Copy Chrl+2
Auto Arrange _— ,
w Align to Grid
Properkies

v Show Desktop Icons
Lack Weh Items on Deskiop
Fun Deskiop Cleanup Wizard

Rename the shortcut

* Move the mouse pointer over the shortcut
* Press the right mouse button

o To view the quick menu for this shortcut
« Select [Rename] from the quick menu
* Type in [Some Balloons] and press [Enter]

0 To rename the shortcut
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Use the shortcut

* Double click on the [Some Balloons] shortcut on the Desktop ﬂ
o The Paint program will open

o [Some Balloons.bmp] will open on screen, ready to edit

* [Close] the Paint program

Tip:
Use the same technique to open shortcut icons to files, folders and directories.
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Exercise 17 Using the Calculator

A Calculator programme is included with Windows software.

From the menu bar, select [Start] [All Programs] [Accessories] [Calculator]
» Using the keyboard, type [6] [+] [4] and press [Enter]
o0 To view the answer to this calculation in the Calculator
» Using the keyboard, type [6] [-] [4] and press [Enter]
o To view the answer to this calculation in the Calculator
» Using the keyboard, type [6] [*] [4] and press [Enter]
o To view the answer to this calculation in the Calculator
* Using the keyboard, type [6] [/] [4] and press [Enter]

o0 To view the answer to this calculation in the Calculator

Caleulator

Edit Wiew Help
0.

’7 Backspace CE ” c l
e ) Ll e L L]
e Lo gl Je JL I
s ) L le e )L ] ]
e ) e Jle J L I

View a Scientific Calculator

» Select [View] [Scientific]

o To view additional functions available if you require them
B x|

Om Owe [ [ [Backspace][ = [ ¢ ]

() (=)0 Lo HED
E3(E3/Y ﬂ K000 3 |
(3£ 3 | 3 K N 3 )
53 3 0 3 3 3 I | 23 | [ N Y
[=])(2)(o]
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Exercise 18 Copy data between programs

* Enter a long number into the Calculator
e From the menu bar, select [Edit] [Copy]
0 To put a copy of this number on the Windows Clipboard

Start WordPad

WordPad is a word processing program that is also included with the Windows

software.

* From the Taskbar, select [Start] [All Programs] [Accessories] [WordPad]

e With the cursor flashing on the screen, select [Edit] [Paste] from the menu bar
o To paste a copy of the long number into the beginning of the WordPad

document

* Press [Edit] [Paste] again
o0 To paste another copy of the long number into the WordPad document

* Press [Enter] on the keyboard
0 To begin a new line in the document
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Exercise 19 Select text

* Inthe WordPad document, type your name.
* Move the mouse pointer to the beginning of your name
* Click and hold down the left mouse button and drag across your name
o To cover your name in a black highlight
o To “select”, “block” or “highlight” the text
e Select [Edit] [Copy]
o To replace the long number on the clipboard with your name
» Click to the right of the selected text
0 To deselect it
o To remove the black highlight
« Select [Edit] [Paste]
0 To paste a copy of your name into the WordPad document at the right of
the original name
« From the menu bar, select [File] [Save]
0 To open the Save As dialog box
» Save the document in the [My Documents] folder with the File name:

[numbers]
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Exercise 20 Work between open windows

This will move between the Calculator and WordPad, using the Taskbar.

* On the Taskbar, click on the [Calculator] button
0 To restore the Calculator to the front of the screen

o To make the Calculator your currently selected window

* On the Taskbar, click on the [WordPad] button
o0 To restore WordPad to the front of the screen

o To make WordPad your currently selected window

* Move between the 2 windows. Use the [Edit] [Copy] and [Edit] [Paste]

commands to move data from Calculator into WordPad and vice versa
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Exercise 21 Use Print Screen

We have just learned about [Copy] and [Paste].

There is a key on your keyboard along the top line of keys called [Print Scrn].

This key “captures” whatever you are viewing on your screen, almost like a
photograph, and temporarily places it on the Windows Clipboard memory. This

image can then be pasted into another application.

* Press the [Print Scrn] button
o To capture your current screen image onto the Windows Clipboard
memory
* Click into your WordPad document
* Select the [Edit] menu and [Paste]
0 To paste the screen image into your document

Tip:

Use the keyboard print screen facility to illustrate your own teaching courseware.
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Exercise 22 Shut down the computer

It is important that you always shut the computer down properly.

* One by one, from the Taskbar, select any programs you are currently working
on
* For each program, select [File] [Exit] from the menu bar
o To ensure that each program, and any documents you are working on in
that program, are correctly closed.
* Click the [Start] button on the Taskbar
» Select [Turn Off Computer]
0 The Turn Off Computer dialog box will open
* Ensure that [Turn Off] is selected
e Click [OK]
o To correctly shut down your computer

Turn oftf computer

Cancel

Some computers switch themselves off automatically once they have shut down
correctly. If you get a message on screen stating that it is now safe to turn off
your computer, it is important to wait for this message before turning the power

off to the computer.

"It is now safe to

turn off your
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